
PowerPoint

PowerPoint is a complete presentation-graphic software package that lets you
create professional and motivating presentations quickly and easily.
PowerPoint has many features that can help you make presentations. You can
include text, graphics, charts, and QuickTime movies. With PowerPoint, you
can create overheads or slides that can be used for lesson, school, or office
presentations. Using PowerPoint, you can also create speaker notes, outline
pages, and audience handouts. PowerPoint is available in both IBM and MAC
formats. In this tutorial you'll learn about the following topics. To examine a
topic, click on one of the links below. When finished with a section, return to
the:
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PowerPoint Basics

PowerPoint has many attributes that you can use in the classroom. Here are
some basic terms that you'll need to know:

Slides are the individual pages of the presentation that can be created as
black and white or color. You may also create 35 mm slides or
transparencies.

●   

Audience handouts are slides that can be printed as 2, 3, or 6 slides on a
page.

●   

Speaker's Notes may contain backup information for presenter along with
a smaller picture of the slide.

●   

Outlines are textual representations of your slides. You can create and edit
all of your text in the outline as well as on individual slides.

●   

PowerPoint provides on-line help, context-sensitive help, and cue cards. In
addition, PowerPoint offers you a tip of the day every time you start the
program. When you move the cursor over the status bar, a yellow box
appears indicating the purpose of the tool.

●   

PowerPoint is an intuitive package in that it is logical and has similar
menu functions to other software packages you might have used.

●   

Return to Table of Contents.

Elements of Screen Design

Many times people get carried away with all of the "bells and whistles" that can
be used in a presentation-graphics program such as PowerPoint. There are so
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many features that it is the first inclination of most of us to cram every feature
we can perform into a single presentation. In most cases, it is unnecessary to
use every feature for every presentation! As a matter of fact, it is critical to be
selective in your choices for instructional delivery. Every time a new slide is
projected on the screen, a new point is emerging in your lecture or discussion.
If the slide is so busy with clip art, video clips, charts, and graphics topped off
with an outrageous color scheme the message will be lost.

Tips

Although motivation is one key element for using PowerPoint, there are
instructional issues that must be considered. It is best to keep in mind that the
focus of your presentation is to deliver a message. Too many bells and whistles
will cloud the message. Sometimes the message is lost completely in the midst
of "gee-whiz" multimedia, movies, and the like. The following are some tips
for designing effective screens that will portray the message in a motivating
way. You may want to download the following tips for later reference. Tip 1:
Always use the KISS principle. (Keep It Simple and Straightforward).

Tip 2: Be consistent. Don't change color on every screen because you can!
There may be times when you are changing focus within a discussion. If so,
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that may be a good time to change the template color. Remember, you want
students to focus on the instruction, not the funny graphic.

Tip 3: Use balance. You may choose a formal and symmetric or an informal
and asymmetric balance. Either way, be consistent (tip 2!)

Tip 4: Promote harmony. To do this, use similar graphic and font styles. For
example, if discussing serious issues using real graphics, don't use a comical
font.

Tip 5: Incorporate only one thought per slide. All text, graphics, videos, charts,
etc. should reflect the 'theme' of the screen. If more than one thought is
depicted, create a new slide for the other thought. If objects on a single screen
are not complementary, cognitive dissonance may occur and the thought will
not be delivered to the audience.

Tip 6: Include no more than two fonts on the same slide. If emphasis is
required, use bold, shadow, and italic to further distinguish concepts.

Tip 7: Include no more than four bullet points of text on a single slide. With
each bullet point, use the 'build' feature to insert one bullet point at a time.
Additionally, you may want to use the 'dim body text' feature so that only the
highlighted bullet point is predominant during your discussion.

Tip 8: Choose graphics carefully for presentation. When chosen properly, they
can add significantly to learning (Schwier & Misanchuk, 1993); when
improperly chosen, they can distract from the learning or result in unrelated
processing (Hannafin & Hooper, 1989).

Tip 9: Select font size and templates that are appropriate to your delivery
medium. For example, if your computer is connected to an LCD panel or a TV
to computer connection device, the left third of the presentation will be lost.
This is called the 3:4 ratio. If delivering via a distance using a document
camera as your connection device, not only with the left-third be lost, the font
size must be larger for the audience to view.

Return to Table of Contents.
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Creating a PowerPoint Presentation

It's time to learn how to create your own presentation! Once mastering this
section, you are on your way to building Presentations with Pizzazz! Be sure to
save this presentation because you can add to it later. Review the lesson on
creating a new presentation and then go to PowerPoint to practice

Creating a New Presentation

The first thing you will see when you open PowerPoint is a dialog box. On this
box, you have the option of using AutoContent Wizards, Pick a Look Wizards,
Templates, Blank Presentation or Open an Existing Presentation from this
screen.

If you select an AutoContent Wizard, you will receive assistance
throughout creating the presentation.

●   

If you select the Pick a Look Wizard, you will go ahead and set your
design for the presentation.

●   

If you select Template, you will choose the template first.●   

If you select Blank Presentation, the default presentation will be used.●   

Open an Existing Presentation will allow you to select from an already
created PowerPoint Presentation.

●   

Select AutoContent Wizard for practice and click OK. Notice how this Wizard
provides a set of Cue Cards. The Cue Cards are available for each function
within PowerPoint. Use them as needed. Also, the AutoContent Wizard
displays the presentation in what is called "Outline View." Many people design
their entire presentation in Outline View then change view to Slide View to
incorporate graphics, movies, etc. (If necessary close and don't save the
autocontent wizard slide). *Tip: If you have an outline that was created in a
word processing program. Select outlines from the list files of type box in the
Open Dialog box. Select the file that contains the outline. Major headings
become new slides, subheadings are bullet pointed.
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Click FILE in the Menu Bar and Select NEW. Select the Pick a Look Wizard
also for practice and click OK. Choose from a wide variety of presentation
templates and styles. (If necessary close and don't save the Pick a Look Wizard
slide)

PRACTICE ACTIVITY

Here is a sample presentation that you can create. If you prefer, you can make
up your own presentation. (You may want to print this section for reference
while creating your sample presentation) Ensure you've started PowerPoint:
Click FILE in the Menu Bar and Select NEW.
Select BLANK PRESENTATION from the dialog box and click OK
On your first new slide, choose an AUTOLAYOUT. Select the title slide
(which is also the default) and click OK.

Type in the following title by clicking in the area marked CLICK TO ADD
TITLE:
CD-ROM: The Magic of Multimedia
Insert your name in the next text-defined area.
Select NEW SLIDE in one of two ways: (1) from the INSERT menu or (2)
from the New Slide Button on the buttonbar.

Select the bulleted list from the Autolayouts function and click OK. Type the
following by single-clicking on the defined area. For the title, single-click on
title. For the text, single-click on the area defined for text. After each bullet
point, use the return key. Notice how PowerPoint automatically inserts new
bullets: Title:
CD-ROM can store:
Text:

graphics●   

sound effects●   

music●   

compressed video●   

animation●   

Select NEW SLIDE.
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Select an Autolayout of your choice and click OK.
Type the following information:
Title: CD-ROM Storage
Text:

Information stored on CD-ROM cannot be modified or erased.*●   

Information is stored digitally.●   

650 mb or 250,000 pages of text can be stored on a single CD-ROM.
*Except new writable CD-ROMs

●   

Select NEW SLIDE.
Select an autolayout that includes a graphic and click OK.
Type the following information:
Title: What about speed?
Text: Accessing information stored on a common hard disk drive is 5 - 10
times faster than accessing information stored on a CD-ROM drive, depending
upon drives.

Graphic: The directions on the slide indicates that you double-click to add clip
art from the PowerPoint clip art library. Double click on the graphic icon. Once
in the clip art library, single-click on the picture of your choice, then select OK.
The picture will be inserted onto the slide. Once inserted, you can enlarge or
reduce the size of the image by clicking-and-dragging the handles (the squares
at each corner of the picture) inward to reduce the size or outward to enlarge. If
you want the picture to remain centered (and proportional), hold down the
control key on the keyboard while you click-drag your picture.

So far we have incorporated five new slides and inserted a single picture from
clip art. Now we are going to add some transitions and builds to the
presentation.

Transitions & Builds

A transition is the way one slide changes to the next. The easiest and most time
efficient way to add transitions and builds to your presentation is to go to the
SLIDE SORTER by clicking on the slide sorter on the bottom left buttonbar on
the PowerPoint screen (box with four blocks inside).

To Add a Transition to all of your slides, select SELECT ALL from the EDIT
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menu. This will select all of the slides that you have created so that the
transition can be applied to all slides at once. You can add transitions to
individual slides if you choose to incorporate specific transitions for individual
slides. Usually, a single transition for all slides or a selection called
"RANDOM" will suffice.

Find the long, narrow button titled NO TRANSITION just above your slides.
Click on the arrow to reveal many different transition types. Select one.

A build refers to how bullet statements are added to a slide during a
presentation. To Add a Build, follow the same procedure except use the toolbar
to the right that says "NO BUILD-EFFECT." Builds will insert the body text
one bullet-point at a time rather than disclosing everything at one time. We
have all been in classes where as soon as the teacher places an overhead on the
projector everyone begins furiously writing every word instead of listening to
the key points stated about each bullet-point. For you as an instructor/presenter,
this will put YOU in control of how much text at a time students are furiously
writing! Choose one of the options for build effect to see what happens.

Now, let's run the presentation!

Single click on the first slide in your presentation. Select the slide show icon on
the bottom button bar for viewing (Icon looks like a portable screen). To
advance from slide to slide, single-click with the mouse or use the forward
arrow on the keyboard. If you need to go back to the previous slide, use the
back arrow key.

When the presentation is finished, the slide sorter will reappear. You can save
your presentation so you can use it later.

Return to Table of Contents.

Adding A Graphic Object to your Presentation
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Using Graphics

PowerPoint has hundreds of clip art graphics that can be used in your
presentation. In addition to the PowerPoint Clip Art Gallery, you have the
option of adding graphics from MS Works, MS Publisher, and others (if
available on your machine). You also have the option of adding clip art in over
20 different file formats to include:

.bmp .wmf .hgl .cgm

.eps .gif .tif .drw

.pcx .pic .dxf .adi

.cdr .wpg .plt .pcd

.pct .tga .dib

Additionally, you can scan images into a bitmap (BTP) file and use it in your
presentation. If a scanner is available to you, be sure to try this technique using
the steps for importing clip art described below. Everything you do with
graphics is managed through the Clip Art Gallery. In the activity below, you
will learn to add a graphic from another application program.

Adding a Graphic to the Clip Art Gallery

Go to the Clip Art Gallery by selecting CLIP ART from the Insert menu (or use
the clip art button with the funny man located on the top button bar). Once in
the Clip Art Gallery, select the OPTIONS button. Select ADD to add a
thumbnail picture. Locate the picture you would like to add by locating the
directory (double-click the file) and locate the picture name. You can go to
other application program directories to locate clip art on your machine. You
can preview individual pictures by selecting the PICTURE PREVIEW button.
You can also choose to add ALL of the picture files by selecting the SELECT
ALL button. To insert into your PowerPoint slide, select OKAY. A dialog box
will appear. You can select a category (sometimes one is already listed). You
can use it or type a new category name in the designated area. You may also
choose to type a DESCRIPTION. Once satisfied, select the ADD button/ You
will be returned to the Clip Art Gallery. You should have a new category with
your picture visible. To return to the other pictures in the Clip Art Gallery,

PowerPoint Tutorial

http://www.uwf.edu/coe/tutorials/technolo/powerpn...edu/~coe/tutorials/technolo/powerpnt/powerpnt.htm (9 of 14) [6/28/2000 4:01:51 PM]



select another category. To insert a file from a diskette, select the drives area by
single clicking on the down arrow key and clicking the a: (or desktop and disk
name on a MAC). This will allow you to read the clip art file on a: drive. Then
follow the steps above for adding the graphic to the gallery.

Return to Table of Contents.

Applying Templates and Backgrounds to your
Presentations

Templates can be used to make your presentation professional looking and very
motivating to your audience. Using templates is one of the primary strengths of
any presentation-graphics program. Artists have created over 100
professional-quality templates that not only are appealing to the eye, but also
have incorporated a color scheme and a font scheme that are in unity.
Templates can be applied regardless of how you "output" your presentation.
For example, you may choose to use PowerPoint as a slide show using a
computer and a projection device (such as an LCD panel). If so, you will select
templates corresponding to the slide show making full use of the entire color
scheme that your computer will allow. If, however, you are using PowerPoint
to print overhead transparencies in either black and white or color on a laser
printer, you also have the capability to select from the overhead templates.
This, of course, will not allow you to make full use of the capabilities of
PowerPoint, but eye-catching templates are still available for transparencies.
There are several ways to apply a template to your presentation.

apply the template through the same dialog box that you selected blank
presentation (after the Tip of the Day box);

●   

apply the template by clicking on the button on the bottom right of the
PowerPoint screen and selecting at any time during the development of
your presentation; or

●   

PowerPoint Tutorial

http://www.uwf.edu/coe/tutorials/technolo/powerp...du/~coe/tutorials/technolo/powerpnt/powerpnt.htm (10 of 14) [6/28/2000 4:01:51 PM]



select the Presentation Template from the Format menu at any time during
the development of your presentation.

●   

By the way, if you apply a template then decide that you do not like it, you can
repeat the following steps to apply a new template. Another tidbit, PowerPoint
templates serve as the background or the master to your presentation. The
template you select will be visible on all slides within the presentation. Many
people ask if a several templates can be applied within a single presentation.
The answer is NO! However, through something called the Slide Master, you
can modify the color scheme of the template within the presentation (this will
be discussed later in the course).

Practice Activity

If you'd like, retrieve your presentation and apply a template to it. One
procedure for applying templates will be used in this activity. You are on your
own to explore other approaches for applying templates. Again, you may wish
to print this page for reference. From the FORMAT menu, select Presentation
Template. (If the appropriate files are not listed, search your hard drive for the
folders.) After selecting, you will see a dialog box containing all of the
PowerPoint template files. Within the template folder, there are three more
folders : (1) bwoverhd (for black and white overheads); (2) clroverhd (for color
overheads); and (3) sldshow (for outputting to an LCD panel, a TV to computer
converter, or an overhead projection system). Double-click on the SLDSHOW
folder. A list of files within the SLDSHOW folder will appear below the file
name box (the left side of the dialog box). Single click on several of the file
names to see a preview of the template. The preview will be in the bottom left
corner of the dialog box. Once you have found a template you like, select it by
single-clicking the file name and selecting APPLY (button on the right side of
the dialog box). You have now applied a template to your presentation. Run
your lesson to see what it looks like! Remember, to run your lesson, scroll back
to slide 1 and double-click on the slide show button on the bottom left
buttonbar.

Return to Table of Contents.
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Speaker Notes and Handouts

There are many other ways that you can use PowerPoint in lessons. These
include the outline view, speaker notes, and handouts. Outline View When you
view your presentation in outline form, you will see the titles and text from the
presentation. Titles appear along with the slide number. The text is indented.
Pictures, charts, art, and graphics are not displayed. What You Can Do with
the Outline View The outline form lets you easily rearrange your text and
slides. Because you can see all of your text at once, it's easier to modify the text
than when you are in the slide view.

Activity

Go to your presentation. Change to the Outline View. Move some information
from one slide to another (click and hold the bullet and drag to a new location).
Then view the slides to see how they have changed. Speaker Notes You may
want to create additional text to go along with each slide you create. Using
PowerPoint's Speaker Notes, you can add your own text that can be printed to
help you keep track of what you want to say in your presentation.

In Speaker Notes, a smaller version of the slide is displayed on top of a page.
At the bottom of the page, there is an area for your notes.

Activity

Go to your presentation. On the first slice, change to the Notes Page View.
Double-click in the body text under your slide. Type: CD-ROMs are often used
in educational situations. In this presentation you will learn about CD-ROMs.

Go to the next slide. Add your own speaker notes that relate to the slide.

Handouts To guide your audience so that they many follow your presentation
or have ready-made notes for after your presentation, you can produce
handouts. Handouts may contain 2, 3, or 6 slides per page. To create a handout,
you will use the print command. Through the Master Handout Screen, you can
manipulate how the handouts will appear.
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Activity

Go to your presentation. From the View menu, select Master, then Handout
Master. If you want text to appear on every page, type outside the outlined
boxed. Return to your slide presentation.

Printing Outlines, Speaker Notes, and Handouts To print one of the options
we've discussed in this lesson, you'll use the print command. Printing
PowerPoint presentations is very similar to printing any other document and is
accessed through the File command on the menubar.

Activity

Go to your presentation. Highlight File, then Print. Under "Print What" choose
handouts, 6 per page. Click OK and your handouts will be printed. Repeat for
outline and speaker notes.

Return to Table of Contents.

Integrating PowerPoint into Instruction

By now you probably have been thinking of ways that you can use PowerPoint
for delivering instruction. PowerPoint, or any presentation-graphics program
can motivate your students by providing a professional presentation that
highlights key points of discussion. It also helps to keep you as a presenter on
track! Most people use PowerPoint for instructor-led presentations. In addition,
you may consider using PowerPoint to develop simple computer-based
tutorials for your students. Keep in mind that PowerPoint is linear and does not
have the flexibility of an authoring program (such as HyperStudio,
AuthorWare, etc.). However, people have created some outstanding
individualized instruction using PowerPoint.

Return to Table of Contents.
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World Wide Web Sites

PowerPoint Home Page●   

PowerPoint on the Web●   

Compadre for PowerPoint●   

Other Presentation Software Packages

Astound●   

Harvard Graphics●   

Persuasion●   

mPower●   

Return to Table of Contents.
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http://www.microsoft.com/msoffice/mspowerpoint/default.htm
http://www.net-scene.com/
http://www.threedgraphics.com/compadre
http://www.mindscape.com/
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